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Congratulations on purchasing Transverter Pro Plus!  A complete PostScript interpreter,
RIP, previewer, and conversion tool.  Use it for the production of illustrated manuals,
service bureau PostScript proofing, illustration work, slide production, presentation, or
anything else that requires a PostScript interpreter.

RIP!
• RIP PostScript Level 2 files to TIFF, JPEG and GIF  format.
• RIP files for your large format output device or edit PostScript files in Photoshop.
• Reduce placed EPS image incompatibilities.  RIP them, then place in Quark or
PageMaker.  No need to worry whether they will RIP in the final output!

Edit!
• Make an entire PostScript file visually editable.  Used with FreeHand, Illustrator, or
CorelDRAW and Photoshop, Transverter Pro Plus makes your PS and EPS files into
visually editable paths, text, and bitmaps.
• Quark and PageMaker users can take any working page, export it as an EPS file, and
make it editable.

Place!
• Get placeable PostScript! Convert PostScript into placeable EPS images.
• Attach previews to EPS files making them viewable in Quark, PageMaker, PowerPoint,
and Persuasion.  No more gray boxes!

View!
• View EPS and multipage PS files on-screen.  No more guessing what’s in a file.
No need to print it to see what it contains.
• Web surfers can add reliable PostScript file viewing to World Wide Web Internet
Browsers like Netscape Navigator and Microsoft Internet Explorer.

Softproof and Preflight!
• Test PostScript files FAST before sending to your output device.  RIP the file to your
screen and inspect it in a fraction of the time a printer can do it.
• Identify missing or incorrect fonts, bad PostScript, and misplaced linked files.
• Visually verify file integrity, accuracy, and font availability.
• Zero in on warnings and errors using the built-in Status window.  See on screen where
a PostScript page fails and quickly identify the problem area.

Introduction
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What’s special and new in Transverter Pro Plus

Advanced Features
High Resolution - user selectable resolution up to 4096 dpi

Hot Folder - automate your workflow with a Hot Folder that Transverter Pro Plus
watches constantly for files to process.

Improvements & Changes
Support for Acrobat 3.0 - Acrobat 3.0 produced a new PDF file format (version 1.2).
Transverter Pro 3.2 supports this new version of Adobe’s software and file format for
raster output formats: TIFF, GIF, and JPEG.

Improved Font Handling - A new folder “Other Fonts” monitors for available
Transverter Pro Plus specific fonts on startup. Font Substitutions information is now
saved when you Quit.  Transverter Pro Plus will now embed fonts when converting to
EPS files.

Job Cancel - Job cancel using Command-Period or the Escape key.

New Component
Security Key - to launch Transverter Pro Plus requires that you shutdown the machine
and install the hardware-based Security Key (a dongle).  See the installation instruc-
tions for important details.

Input Files
PostScript Level 2 (.ps), Encapsulated PostScript (.eps), Print to Disk PostScript (.prn)
Adobe Acrobat (.pdf).  File extensions represent Microsoft Windows file types.

Output Formats
Raster:  TIFF, GIF, JPEG.
Vector:  EPSF, Adobe Illustrator 1.1, Adobe Illustrator 88, Adobe Illustrator  3.0, PICT.

Introduction
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System Requirements
To use Transverter Pro Plus Plus you will need:
1.  A PowerPC or 68040 Macintosh
2.  System 7.5 or later
3.  At least 100 megs of free hard disk space
4.  12 megabytes of RAM for Transverter Pro Plus
5.  The Helvetica font must be installed in your System Font folder.  This is the Default
Font - see Troubleshooting: Font Substitutions for a full explaination.

Transverter Pro Plus Installation
The Transverter Pro Plus CD contains the application program and supporting files.
There are three basic components that are installed:

• Transverter Pro Plus application
• Supporting files contained in two folders (Lib and Resource)
• Special font directory: Other Fonts
• Hot Folders defgault directories (4)

1.  Insert the CD into your computer.
2.  Open and drag the Transverter Pro Plus folder onto your hard drive.
3.  Now install the Transverter Pro Plus hardware Security Key.

a.  Do a Save in all running applications and then Quit them.
b. Shutdown the machine and ALL peripheral devices/components.

- Install the Security Key which is an ADB (Apple Desktop Bus) device.  Choose either
(1) between the keyboard and Macintosh or (2) on the spare ADB port on the back of
the Macintosh (it can hang there all by itself) or (3) between the mouse and the key-
board.  If you do not understand what an ADB port is or how to install a device onto it
see your Apple Macintosh Users Guide or contact your Apple Reseller.

c.  Restart your Macintosh.
Note:  DO NOT install the Security Key while your Macintosh or any other
peripheral atttached to the machine is powered on.  The Macintosh and all devices
attached to it must have the electricity turned OFF this includes, but is not limited
to,  items on the printer port (eg. printers), the modem port (eg. modems, digitiz-
ing pads), the SCSI port devices (eg. hard drives, scanners, printers), the monitor
port (monitors), and the ADB bus (eg. modems, drawings tablets).

4.  Launch Transverter Pro Plus by double-clicking on the icon.
5.  Now begin using Transverter Pro Plus by following the Quick Start examples or
move to the Using Transverter Pro Plus section of this Users Guide.

Getting Started
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Getting Started

Quick Start Examples
This section is designed to provide you with examples of how to use Transverter Pro
Plus in your everyday operations.  Hopefully, from these example sessions you will be
able to quickly learn how to use Transverter Pro Plus and immediately begin using it in
your everyday operation.  Following these sessions are more in depth explanations of
Transverter Pro’s features for use as a reference.

Session #1 – Viewing and Editing a PostScript file
You were given an EPS image to use with a newsletter you are working on.  You need
to place the image into Adobe PageMaker™, but only get a gray box.  You need to be
able to see the image on-screen so you can format text around it.

First – Preflight On-Screen
The reason you only get a gray box when importing to PageMaker is because there is no
preview attached to the EPS file or PageMaker cannot read the preview.  To attach a
screen preview for PageMaker to use, launch Transverter Pro Plus and select Open...
from the File menu.  From the Open dialog box, double-click on the EPS image.
Transverter Pro Plus will display the Viewing Options window.  For descriptions of the
options on this window, refer to the Viewing a File section in this manual.  Once you
have your viewing options set, click OK .  Transverter Pro Plus will rasterize the image
and display it (Figure 1).

          Figure 1 – Viewing the EPS file
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Second – Prepare the File for Editing
When viewing the file, you notice that there are some changes needed in the image.
You decide you are going to need to edit the file with Macromedia FreeHand®.
Transverter Pro Plus can create a file editable in FreeHand.  FreeHand can then import
it.  To create an editable FreeHand file, which imports as an Adobe Illustrator file, select
Export  from the File menu.

When the Export window is open, select the Adobe Illustrator 3.0 format from the
Format pop-up menu.  Enter the file name me for the Export and click on Save.
Transverter Pro Plus will next display the Illustrator 3.0 Options window.  Change the
options to your preferences and click on OK .  For more information on these options,
refer the the Output Format Options section.  The file will be exported and saved as the
name you typed in.

Third – Edit the Image
Launch FreeHand, from the File menu choose Open...

Notice that there is a large difference between “placing” the AI file as an EPS file and
“opening.”  When you place an EPS file into FreeHand, you are placing an uneditable
graphic.  You will only have limited control over the image, for instance moving and
cropping.  With the help of Transverter Pro Plus, you have created a file that can actu-
ally be edited by FreeHand.

Getting Started
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When the image is opened, all paths will be grouped to form one large object.  To
ungroup the paths for editing, click on the image, selecting it, and from the Arrange
menu choose Ungroup (Figure 2).

Figure 2 – Ungrouping the Paths
After editing the file, you can save it as an EPS file and place it into PageMaker using
Place under the File menu.

The result is a preview of your image on the PageMaker page instead of the gray box.
Now you can see exactly where the image is and can accurately wrap text around it.

Getting Started
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Getting Started

Session #2 – RIP EPS files to TIFF
You have a large collection of EPS files that you need to edit in a bitmapped editing
program, such as Adobe Photoshop™.  You need to quickly and precisely rasterize the
EPS files to a high resolution TIFF that can be imported into Photoshop.

Batch Converting to TIFF
Instead of opening each EPS file, viewing it, then exporting it, Transverter Pro Plus
allows you to perform a batch conversion.  A batch is a collection of files that are all to
be processed the same way.  In this case, our batch is the large collection of EPS files
that are all to be made into high resolution TIFFs.

To begin, launch Transverter Pro Plus and select Batch Convert... from the File menu.
Transverter Pro Plus will open the Batch window.  From this window, you can add files
to the batch by clicking on Add and remove files from the batch by clicking on Re-
move.  You can also change the destination folder using the Folder... button.  Finally,
select TIFF from the Output Format  pop-up menu.  If the original output format was
not TIFF, Transverter Pro Plus will display the TIFF Options window.  If TIFF was
already selected as the output format, click on the Options... button to get this window.
You can customize how your files are rasterized.  For details about this window, refer to
the Output Format Options section.   When you are satisfied with the TIFF options,
click on OK .  Transverter Pro Plus will return you to the Transverter Pro Plus Batch
window.  If you are ready, click on Start and Transverter Pro Plus will begin rasterizing
the files for you.  Depending upon the size and quantity of your files, the rasterizing
will take varying amounts of time.

When Transverter Pro Plus is finished rasterizing the EPS files to TIFF, open them into
Photoshop.  Launch Photoshop and select Open... from the File menu.

Locate one of the converted files in the open dialog box and double-click on it.  Photoshop
will open the file for editing.

The next section in the Users Guide will show you the specifics of how to work with
Transverter Pro Plus Plus.
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In this section is a more thorough explanation of Transverter Pro Plus’ features.

Status Window
The Status Window (Figure 3), is Transverter Pro’s means of communicating to you.  In
it will appear font information and any PostScript errors as well as a listing of the files
processed.

Figure 3 – The Status Window

Viewing a PostScript, EPS, or Acrobat PDF File
To view a file, from the File menu, select Open...  Transverter Pro Plus will display an
open dialog box; locate and double-click on the file you would like to open.   As the file
opens it is checked to determine which file format it is, PostScript, EPS, or PDF.  De-
pending upon the format, different viewing options will be available.

Ignore DSC Comments
Document Structuring Conventions (DSC) Comments are information placed into a
PostScript file (they don’t  occur in EPS or PDF files) to assist page management sys-
tems in working with a PS file.  Occasionally Transverter Pro Plus will get an error
message when viewing a PostScript file because of  DSC Comments.  If you are trying
to view a PS file but get an error try checking this box, located in the Open file dialog
box and then view the file.  Frequently this solves the problem/

File Viewing Common Options

Rotation and Mirroring
Rotation and mirroring can also be changed when viewing.  Rotations in increments of
90 degrees are available under the Rotation pop-up menu and mirrorings of None,
Vertical, Horizontal, or Both are available under the Mirroring  pop-up menu.

Using Transverter Pro Plus
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Using Transverter Pro Plus

Resolution
From the Resolution pop-up menu, the resolution can be selected.  Monitors typically
display at only 72 or 96 dots per inch (dpi), but if you intend to zoom into the image and
look at fine detail, you may need to use a higher resolution.  On the pop-up menu are
some of the more common resolutions along with short descriptions of where they are
typically used.  If the resolution you desire is not on the pop-up menu, select Custom
and enter your custom resolution in the text box below.  The resolution you chose only
applies to viewing the file and not to exporting or converting.

Color Space
Finally, the Color Space pop-up menu allows you to select the type of color space you
would like.  Available are Monochrome (1-bit), Graytone (8-bit), RGB Palette Color
(8-bit), and RGB True Color (24-bit).  CMYK is not available for viewing on-screen as
screens are only RGB.  The color space you chose only applies to viewing the file and
not to exporting or converting.

PS Viewing Unique Options
If Transverter Pro Plus determines that the file you are opening for viewing is a PostScript
file, it will display the PS Viewing Options window (Figure 4).  From this window,
you can customize how the file is displayed on screen.

Figure 4 – PS Viewing Options Window
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Using Transverter Pro Plus

Page Size
When opening a PostScript file, you must select the page size to use when displaying
the image.  To do this, first choose the measurement scale you would like to use from
the upper right pop-up menu (displaying “points” in  the figure).  After selecting the
measurement scale, select a page size from the top pop-up menu.  Popular page sizes
are available, but you can also enter a custom page size, or a page size not on  the menu,
select custom from the Page Size pop-up menu and enter the desired dimensions in the
text boxes.

EPS Viewing Unique Options
If Transverter Pro Plus determines that the file you are opening for viewing is an EPS
file, it will display the EPS Viewing Options window (Figure 5).  From this window,
you can customize how the file is displayed on screen.

Figure 5 – EPS Viewing Options Window

Use EPS Bounds As Page Size
EPS files contain a statement which defines the page size for the image.  If this check
box is checked, this page size will be used and the dimensions will be displayed in gray
text in the page size text boxes.  You can change the measurement scale used in these
dimensions with upper right pop-up menu (displaying “points” in the figure).
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Page Size
If the Use EPS Bounds As Page Size check box is checked, the Page Size pop-up
menu will be grayed and the page size will be determined from the EPS file.

If you would prefer to use a different page size than the one specified in the EPS file,
uncheck the Use EPS Bounds As Page Size.  Next, select the page size you would like
from the Page Size pop-up menu.  Popular page sizes are available, but you can also
enter a Custom page size, by selecting custom from the Page Size pop-up menu and
enter the desired dimensions in the text boxes.  You can change the measurement scale
used in these dimensions with the upper right pop-up menu (displaying “points” in the
figure).

PDF Viewing Unique Options
If Transverter Pro Plus determines that the file you are opening for viewing is a PDF
file, it will display the PDF Viewing Options window (Figure 6).  From this window,
you can customize how the file is displayed on screen.    Available options are as fol-
lows.

Figure 6 – PDF Viewing Options Window

NOTE:  Page size is not shown because the PDF file contains the page size already.

Using Transverter Pro Plus
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Transverting a Single File
There are two ways to convert a single file.  The first method is to start by viewing the
file, then select Export Page... or Export Selection... from the File menu.  Transverter
Pro Plus will prompt you for the output format.  This method has the advantage of
letting you softproof the image before converting.

The second method is to treat the single file as a batch.  Transverter Pro Plus processes
a batch without rasterizing to the screen.  This eliminates the overhead required for
viewing and allows your files to be converted more quickly.  The disadvantage is not
being able to softproof the image.  If you do not need to softproof the image, convert the
image by going to the File menu and selecting Batch Convert...

Transverting a Batch
Many times you will need to transvert a large number of files all in the same manner.
To make this easier, Transverter Pro Plus allows you to process files in “batches.”  When
transverting a batch the same processing is done to all of the files.

To run a batch, select Batch Convert... from the File menu (Figure 7).

Figure 7 – Transverter Pro’s batch window

Using Transverter Pro Plus
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Using the Output Format  pop-up menu at the top of the window, select your output
format.  Available are EPSF, TIFF ,Adobe Illustrator 3.0, 1.0, and 88, PICT Vector,
JPEG and GIF.  After changing the output format or clicking the Options button,
Transverter Pro Plus will display a window for choosing output format options.  This
window is specific to the output format chosen.  These options are described in the
Output Format Options section.

By clicking on the Folder button, you can select the destination folder for your con-
verted files.  By default, Transverter Pro Plus writes converted files into the folder T-
Pro Ouptut on the Desktop.

Click on the Add button to add files to the batch to be transverted (Figure 8).

     Figure 8 – Batch Add Window

The Batch Add Window contains two scrolling areas.  The top scroll area is a list of files
and folders on your hard drive.  All selections for files to be added occur in the top
scroll area.  The bottom scroll area contains a list of the files in the batch.  To add a file
to the batch, go to the file in the top scroll area and double-click on it.  If you would like
to add all the files in a folder, open the folder in the top scroll area, displaying all the file
names in the top box, and click on Add All .  You may add any number of files from any
number of folders.  Finally, to remove a single file from the list in the bottom box,
double-click on it; to remove all files from the batch, click on Remove All.  When you
have add all of the files you would like in the batch, click Done.  After you are satisfied
with the contents of the batch, click on Start to begin processing the files.

Drag and Drop Files
You can drop files onto the Transverter Pro Plus icon.  When a file is dropped onto it,
Transverter Pro Plus will process it the same way you processed the last file transverted.
For example, if you were viewing a file when you last quit and you drag a file onto the
icon, the file will be viewed using the viewing options you last chose.  Also, if you were
batch converting to EPSF, the file you dropped will be converted to EPSF using the last
set of options you set when transverting an EPSF file.

Using Transverter Pro Plus
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Using Transverter Pro Plus

Automation - Hot folders

Getting Started
Begin by setting up the items in the Hot Folders dialog box:
1. Select Hot Folders from the File menu
2. Choose the Output Format
3. Click the Options button and select the resolution, color settings, etc.
4. Note the the Folder Setup section.  We suggest you begin by using the four
Default Folders installed in the Transverter Pro Plus folder during installation.  Later
you can change these to any location you choose and/or specify how what to do with
the Source file if processing is sucessful.  Such as, moving the file to the Trash or
having it deleted.
5. Click the Start button to begin automatically processing files placed into the Source
folder.

Job Cancel
If during processing you decide to end a  job press the key combination Command-
Period  (  - .) or the Escape key.  This stops the Hot Folder processing and resets the
Stop button to Start.  To resume processing click on the Start button.
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Using Transverter Pro Plus

Hot Folders Setup
The Transverter Pro Plus folder contains four (4) folders to ease your initial setup.
They are:

•  T-Pro Input as the Source folder
•  T-Pro Output as the Destination folder
•  T-Pro Errors as the Errors folder
•  T-Pro Originals as the Saved folder

Source folder (default: T-Pro Input folder)
This is the Hot Folder (some people call this a Watched Folder).  Any file placed into
this folder will be processed by how you setup Transverter Pro Plus.  You can Drag &
Drop or Copy a PostScript, EPS, or PDF file into it for processing.

Destination folder (default: T-Pro Output folder)
Successful file processing writes the new file here.

Errors folder (default: T-Pro Errors folder)
Files are moved from Source folder into the Error folder if they cause an interpreter
error while processing.  Also, while processing a file pressing Command-Period will
immediately stop the Hot Folder feature and the file currently being processed to the
Error folder.

Saved folder (default: T-Pro Originals folder)
Source files can be moved here after processing you if have chosen Move source
file to Saved folder on success.  This allows you to reuse the original file again .
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Other choices for Source file(s) disposition
Above we showed you how you can move your Source files to a Saved folder after
processing.

However, there are two other choices for post-processing Source file actions:
1.  Move Source file to the Trash.  Source files will automatically be moved
to the Trash.  However, as an added safety factor to change your mind about disposal
you must manually select Empty Trash to delete the files from your machine.

2.  Move Source file to Deletion.  Be careful with this option this choice
completely deletes the Source file from your Macintosh.  Be absolutely sure you (a)
have a backup copy of the original file or (b) are positive you will never ever need the
Source file(s) again after processing through Transverter Pro Plus.

Using Transverter Pro Plus
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Font Options
Transverter Pro Plus allows you to customize which fonts are used when transverting
your images.  To view the Font Options select Font Options from the Edit menu (Figure
9).

Figure 9 – The Font Options Window

System Type 1 PostScript, System TrueType Fonts
The PostScript Type 1 fonts installed on your System are listed in the upper left scroll
box and in the upper right are the TrueType fonts.  Both of these font types are stored in
your System folder, typically in the Fonts folder.  These fonts are also the ones available
to your applications.  If you would like to not use one of these fonts when transverting
images, highlight the font and click on the Disable button below the box in which the
font is located.  To enable a disabled font, select the disabled font and click on Enable.
Finally, if you would like to disable all of one type of font, click on the Disable All
check box for that font type.

Other DOS and Mac Fonts
You can make fonts, not installed on your System, available exclusively for Transverter
Pro Plus.  To add fonts here just copy the font files into the Transverter Pro Plus “Other
Fonts” folder.  Then start or restart Transverter Pro Plus to make the fonts available.  On
startup the fonts will be verified and added.  Corrupt fonts will not be added.

Using Transverter Pro Plus
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When verifying, Transverter Pro Plus looks to see if the font is a font suitcase, Mac
PostScript Type 1 font, Mac TrueType font, or PC DOS format PostScript font (.pfb file
extension).  If the font is none of these types, it will not be added.

To insure proper Transverter Pro Plus font finding some rules apply to Suitcases:
-  A TrueType (TT) font is only one file (versus PS fonts consisting of two files).  The
Suitcase may contain multiple TT fonts.

Figure 10 – A TT Font Suitcase Figure 11 - Inside the TT Font Suitcase

In the example above (Figure 10 and Figure 11) Impact is a single TrueType font con-
tained within the Systems Fonts Folder in a Suitcase.

- Type 1 PostScript font requires two files to work.  The Screen Font file and the Printer
Font file.  The Screen Font file is contained inside the PS Suitcase and the Printer Font
file must be contained in the folder the PS Suitcase sits in.  Lack of one or both files will
cause the font to not be recognized or usable by any Mac application including Transverter
Pro Plus.

Figure 12 – PS Suitcase and PS Fonts Figure 13 – Inside the PS Suitcase

In the above example the Fonts Folder (Figure 12) contains the Helvetica PostScript
Suitcase and the PS Printer Font files.  The PS Suitcase itself (Figure 13) contains the
Screen Font files in different point sizes for screen viewing.

 If these rules are not observed Transverter Pro Plus cannot add Other DOS and Mac
Fonts.  Transverter Pro Plus supports font handling with Symantec’s Suitcase II, Adobe
Type Manager (ATM), Master Juggler, and Font Reserve.

Using Transverter Pro Plus
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Font Substitutions
In the bottom right-hand corner of the Font Options dialog box is the Font Substitu-
tion List  scroll box.  When a font is used that Transverter Pro Plus does not have access
to, a substitution must be made.  All text in a PostScript file is either printed with the
proper font, substituted with a Specific Font Substitution, or substituted with the
Default Font.

A Specific Font Substitution is when one font is substituted for another font.  For ex-
ample, you can set Helvetica to always substitute for the Arial font.

The Default Font  is the font that is substituted for a font requested by a print job that is
(1) not on your System and (2) not in the Other DOS and Mac Fonts list and (3) does not
have a Specific Font Substitution.  In other words, use of the Default Font occurs when
Transverter Pro Plus cannot locate a font by any other means.

To create a Specific Font Substitution, click on the Add button below the Font Substi-
tution List scroll box and the Font Substitution dialog box appears. (Figure 14).

Figure 14 – Adding a Font Substitution

In the Original Font  text field, type the exact name of the font to have a substitution
occur.  It is very important to be sure the font name is spelled correctly, including any
spaces, capitalization, and punctuation.  It may be easier to cut and paste the font name
from the Transverter Pro Plus Status Window, if the file has already been run and the
Default Font was substituted as seen in the Status Window.

Using Transverter Pro Plus
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After entering the Original Font , select the substitution font from the Gets Substi-
tuted With:  list.  This list combines all the fonts from the System Type 1, System
TrueType, and Other DOS and Mac Fonts lists.  When you are finished, click on OK .
Now the new font substitution will be seen in the Font Substitution List.

To edit a Font Substitution, select one from the list and click on Edit .  Note that you can
also select the <Default Substitution> at the top of the list and edit this font.  After
clicking on the Edit button, the Font Substitution window will appear as before, but
with the Original Font  text box filled in.  You can now select a different substitution
font from the list or change the name of the original font.  When you are finished, click
on OK  and the changes will be seen in the Font Substitutions List.

To remove a substitution, select the font in the Font Substitutions List then click on the
Remove button.

Using Transverter Pro Plus
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Viewing Window Button Bar
When viewing a file with Transverter Pro Plus, a viewing window is created that con-
tains the image.  At the top of the window is a button bar (Figure 15).

Figure 15 – Viewing Window Button Bar

The three left-most buttons will always be available and usable.  The remaining five are
for handling multiple page files.  If the file you are viewing does not have multiple
pages, these buttons will be  shaded gray and unavailable.  A description of each button
follows.

The arrow tool is used to select an export region.  By dragging the arrow
tool to form a box, you can select a portion of the file to export.  Then, choose Export
SelectionSelectionSelectionSelectionSelection from the Fi leFi leFi leFi leFi le menu to export.

The hand tool is used to navigate through the page.  You can move the page
by selecting a point and dragging the page.

The zoom tool is used to zoom in and get a closer view of the image.  After
selecting the tool by clicking on it, you can zoom into an area by clicking in the center
of it.  You can also use the zoom tool to select a viewing region.  Drag the tool to form
a box.  Transverter Pro Plus will zoom appropriately to fill the Viewing window with
the zoom selection.  To zoom back out, hold down the Option key, changing the plus
sign to a minus sign, and click on the image.

Clicking on the first page button puts you at the beginning of the file and
on the first page.  This button will only be available if you are not on the first page and
there are multiple pages.

Using Transverter Pro Plus
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Clicking on the previous page button will move you to the previous page.
If you are on the first page or there is only one page, this button will be grayed and
unavailable.

Clicking on change page button will allow you to enter a specific page to
change to.

Clicking on the next page button will advance you to the next page.  If you
are on the last page or there is only one page, this button will be grayed and unavailable.

Clicking on the last page button advances you to the final page.  If you are
already on the last page or there is only one page, this button will be grayed and un-
available.

Uninstalling Transverter Pro Plus
All that is required to uninstall Transverter Pro Plus is deleting the Transverter Pro Plus
components and rebuilding the desktop.  This is described in the following steps:

1.  Drag the Transverter Pro Plus 3.2 folder to the Trash.
2.  In your System Folder open the Preferences folder.
3.  Drag the T-Pro 3.2 Preferences file to the Trash.
4.  Select Empty Trash from the Special menu.
WARNING!  This will delete ALL items in the trash, not just Transverter Pro Plus.
Make sure there is nothing else in the Trash you want to save.
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Output Formats
There are a number of output format options, specific to each of the different formats
available.  The options will appear in their own window when you either select a differ-
ent format or click on the Format Options... button when converting. Some options
are common to all file formats.  These options are found in the Common Output Op-
tions section.  Other options are common to all Raster (TIFF, GIF, and JPEG) formats
and are covered in the Raster Common Options section.

Common Output Options
These options work with every format output by Transverter Pro Plus.

Rotation
Choose the rotation you would like via the Rotation pop-up menu (Figure 16).  Avail-
able are all 90 degree rotations.

Figure 16 – Rotation Options

Mirroring
You can also specify how you would like the output mirrored via the Mirroring  pop-up
menu (Figure 17).  Available options are None, Vertical, Horizontal, or Both.

Figure 17 – Mirroring Options

Raster Common Options
Page Size
If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
Instead, the Page Size will be the size you specified when you opened the file or if you
have selected a region, will be the size of the region.  The Page Size dimensions will be
displayed at the top of the TIFF Options window (Figure 18).



○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

- Page 27 -
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Output Formats

Figure 18 – Page Size dimensions

Choose the measurement scale you would like to use from the upper right pop-up menu
(displaying “inches” in  the figure).  After selecting the measurement scale, select a
Page Size from the Page Size pop-up menu (Figure 19).  Popular page sizes are avail-
able, but you can also enter a custom page size by selecting Custom from the Page Size
pop-up menu and entering the desired dimensions in the text boxes.

Figure 19 – Page Size Options

Resolution (dots per inch, dpi)
The resolution for the bitmapped image can be selected via the Resolution pop-up
menu.  Some standard resolutions are available on the pop-up menu (Figure 20), but a
custom resolution can be entered by selecting Custom from the menu and entering
your own horizontal and vertical resolutions.  The maximum resolution is 4096 dpi.

                Figure 20 – Resolution Options

For information on the Calculated option, see the Calculated Images section.
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Output Formats

Raster Size (number of pixels)
The Raster Size pop-up menu (Figure 21) allows you to specify the number of pixels in
the horizontal and vertical dimensions to be used in the image.  Custom dimensions can
also be used by selecting Custom and entering the horizontal and vertical dimensions.

Figure 21 – Raster Size Options

Calculated Images
A relationship exists between Page Size, Resolution, and Raster Size as shown by the
following formula.

Raster Size (horizontal and vertical pixels) = Page Size x Resolution (dpi)

Your goal: A specific Number of Pixels in an Area
For example, say you want to create an image that contains 640 horizontal and 480
vertical pixels in 5” horizontal  x 3” vertical.
First select the Page Size you want.  Next from the Raster Size option choose Custom
and enter the number of pixels you want in the horizontal and vertical directions (e.g.
640h x 480v pixels).  Transverter Pro Plus will now automatically calculate a Resolu-
tion (128h x 160v dpi).

Your goal: A specific Density of Pixels (dpi) in an Area
For example, say you want a 4” horizontal x 6” vertical image at 720 dpi.
First select the Page Size you want.  Next from the Resolution option choose Custom
and enter your desired dots per inch (e.g. 720 dpi).  Transverter Pro Plus will now
automatically calculate the Raster Size (2880h x 4320v pixels).
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Output Formats

Color Space
The Color Space pop-up menu (Figure 22) allows you to select the type of coloring
you would like.  Available are Monochrome (1-bit), Graytone (8-bit), RGB Palette Color
(8-bit), RGB True Color (24-bit), CMYK True Color (32-bit).

Figure 22 – Color Space Options

Antialiasing
The Antialiasing pop-up menu (Figure 23) allows you to select the type of antialiasing.
There are two types of antialiasing, pyramidal and box.  Each of these types are avail-
able at three levels, low, medium, and high.  Antialiasing is supported for Graytone (8-
bit), RGB True Color (24-bit), and CMYK True Color (32-bit) and not supported for
RGB Palette Color (8-bit) or Monochrome (1-bit).  For a more complete description
refer to the Antialiasing section in the Reference Manual.

Figure 23 – Antialiasing Options
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Output Formats

Raster Output Formats (TIFF, JPEG, GIF)

TIFF
This format supports the Raster Common Options discussed earlier in this section.

Figure 24 – Compression Options

Compression
You can select the compression method you would like to use in creating the TIFF file
via the Compression pop-up menu (Figure 25).  Before selecting a compression method,
be sure the application you are intending to import the image to supports that compres-
sion method.

The compression methods available for all Color Spaces are None and LZW.  The
CCITT Group 3 and CCITT Group 4 compression methods are available only for Mono-
chrome (1-bit), as these are fax formats.
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Output Formats

Some graphic file viewers read CCITT Group 3 encoding differently.  Therefore
Transverter Pro Plus 3.2 has two versions available.  If lines appear in your Group 3
viewer try using the Group 3 - No EOL version.  This No EOL (End-of-Line) version
removes the EOL at the end of each stripe of data.

Figure 25 – Compression Options

GIF
This format supports all of the Raster Output Format Common Options except
Antialiasing and Color Space.  The GIF format only supports the RGB Palette (8-bit)
Color Space.  Antialiasing is not supported because Transverter Pro Plus does not sup-
port antialiasing in this color space.  An additional option is the Interlace Bitmap check
box.

Interlacing
If this check box is checked, Transverter Pro Plus will Interlace the GIF.  Otherwise it
will be non-interlaced.  Interlacing permits faster previewing of Internet and Intranet
based images by displaying every other line first.

JPEG
This format supports all of the Raster Output Format Common Options but limits the
Color Space selection.  Available are Graytone (8-bit), RGB True Color (24-bit), and
CMYK True Color (32-bit).  In addition, the Q Factor used in the JPEG can be set.

Q Factor
This allows you to control how much compression is used when creating the JPEG file.
The more compression used, the more image quality lost.  One (1) is the default and
standard number used.  The typical range of Q Factor compression numbers is between
0.1 and 100.  The higher the number, the more compression, but also the more loss of
image quality.
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Output Formats

Vector Output Formats (EPSF & AI)

EPSF (Encapsulated PostScript)

Figure 26 – Compression Options

Page Size
If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
The Page Size you specified when you opened the file or the region you have selected
with the Arrow Tool will be used instead.

Select a Page Size from the Page Size pop-up menu (Figure 21).  Popular page sizes are
available, but you can also enter a custom page size, or a page size not on  the menu, by
selecting Custom from the Page Size pop-up menu and entering the desired dimen-
sions in the text boxes.

Using Auto, Transverter Pro Plus will calculate the smallest Page Size (Bounding Box)
that can surround all the objects within the input file.



○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

- Page 33 -
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Output Formats

Use EPS Bounds If Possible
If you are exporting a file you are viewing, this check box will not appear.  If this check
box is checked and the file is an EPS file, the page size will be drawn from Bounding
Box comment found in the input file.  In all other cases, the page size selected with the
Page Size pop-up menu will be used.

Font Embedding
Fonts may be embedded into the EPSF file to ease font problems when printing.  A font
that is already embedded into an input file (PS, EPS, or PDF) is maintained in the
output (EPSF) file.  This feature adds fonts that are not already in the input file.

Example #1 - PDF to EPSF (all fonts already embedded)
An advertiser sends in an ad in the form of a PDF file to a newspaper for placement.  All
the fonts used in the ad were embedded into the file by the advertiser.  The newspaper
needs to convert the PDF into EPS for placement in the news pagination system.
Transverter Pro Plus converting the PDF will maintain all the embedded fonts in the
output EPSF file.

Example #2 - PostScript to EPSF (no fonts embedded)
A file created by printing PostScript to Disk from a QuarkXPress project with two
pages in it needs to be made into two separate EPSF files.  The original PostScript file
has no fonts embedded.  Running through Transverter Pro Plus from PS to EPSF will
embed fonts, provided that the fonts called for in the file are available on the machine
Transverter Pro Plus is running on.

Example #3 - EPSF to EPSF (some fonts embedded)
An EPSF file requiring 6 different fonts to print properly is made on a Macintosh ma-
chine and 4 of the 6 fonts are embedded into the EPSF file.  The file is moved onto a
Windows machine, placed in PageMaker, and printed to the same printer as was the file
when made on the Mac.  The EPSF file prints 4 fonts correctly but the other 2 typefaces
look wrong having either been substituted with Courier or not matching in their charac-
ter width.

The solution is to run the file throught Transverter Pro Plus  and embed fonts using the
EPS font embedding option to embed fonts.  This provides font fidelity cross-platform.
In other words, moving files cross-platform can cause problems with the same fonts not
being available or with fonts having different character widths in their cross-platform
version, even when printing to the same printer.  The font embedding option can allevi-
ate this issue for you.



○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

- Page  34 -
○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Output Formats

Use Binary Data
This option creates EPS files in binary rather than ASCII format.  The benefit is that
files can be smaller and move more quickly over your network or the Internet.  This
works well in Macintosh environments.

NOTE: A problem can occur if the EPSF, with Binary Data, is going to be used in the Microsoft
Windows network operating environment.  Here PostScript printers working from an NT
Server spooler can crash the printer  (spewing out pages with jibberish text on them) or act
like they will print then nothing appears out of the printer.  We suggest you not use the Binary
Data feature when an EPSF file may need to be printed on a PostScript printer under the
control of a Windows environment.

Create PostScript Level 2
Level 2 PostScript brought many advantages over Level 1 including better color han-
dling.  The default for this option is On.

Use Color Image Operator
PostScript Level 1 did not support a complete color model so an extension was added to
Level 1: Color Image Operators.  Most Level 1PostScript printers understand these
operators and the feature can be used. This option is grayed out unless “create PostScript
Level 2” is unchecked.

Use JPEG Compression
Provides JPEG image compression in PS Level 2 files. It will be grayed out if you
uncheck “Create PostScript Level 2.”  This feature compresses embedded images to
reduce file size

Preview
You can choose the type of preview you would like to attach to the EPSF file via the
Preview pop-up menu.  Available options are None, Mac Color (PICT), Mac B/W (PICT),
DOS Color (TIFF), DOS B/W (TIFF).

NOTE: saving EPSF files with a DOS Color Preview makes them cross-platform compatibile.
Macintosh Quark and Pagemaker will accept them and display a color preview, as well as
their Microsoft Windows counterparts.  Other products like FreeHand and Microsoft Word
can also take advantage of this feature.

Copy Original EPS When Possible
Check this box if all you want to do is quickly attach a Screen Preview to an EPS file.  If
this box is checked  your original file’s EPS code is used to create a Screen Preview.
The preview is then attached to the original file  (Copy Original EPS).   The When
Possible means the option only works if the input file is an EPS.  If it is a PostScript or
PDF file Transverter Pro Plus must first create an EPS file then attach the preview.
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Output Formats

Adobe Illustrator 3.0, 88, 1.1
These formats support text to outlines, filtering of PostScript data, and attaching pre-
views.

Format Selection
Adobe Illustrator 3.0 - most  draw programs on Macintosh and Windows support this
file format for editable import.  It supports masks and compound objects.  FreeHand 5.0
and above will import AI 3.0 files.
Adobe Illustrator 88 - this format is maintained for backwards compatibility.
Adobe Illustrator 1.1 - does not support custom colors, compound objects, or masking.

Text To Outlines
Transverter Pro Plus can also change the fonts contained in your image to text outlines.
If you would like this to always be done, select Always from the Text To Outlines pop-
up menu (Figure 27).  If you would like outline fonts to never be created, select Never.
Finally, if you would like Transverter Pro Plus to decide, choose When Appropriate.
For more information see the Text to Outlines section in the Reference Manual.

Figure 27 – Text To Outlines Options

Filters
You can select to filter objects from a PS or EPS file when transverting.  If you would
like to filter ALL bitmaps, paths, or text from your image, select the appropriate check
box or boxes from the three Filter Out check box options.  Refer to the Reference
Manual for more information.

Preview
You can choose the type of preview you would like to attach to the Adobe Illustrator file
via the Preview pop-up menu (Figure 20).  Available options are None, Mac Color
(PICT), Mac B/W (PICT), DOS Color (TIFF), DOS B/W (TIFF).

NOTE: saving AI files with a DOS Color Preview makes them cross-platform compatibile.
Macintosh Quark and Pagemaker will accept them and display a color preview, as well as
their Microsoft Windows counterparts.
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Output Formats

PICT Vector
This format supports page size, text to outlines, and filtering of PostScript data.

Page Size
If you are exporting a file you are viewing, the Page Size pop-up menu will not appear.
The Page Size you specified when you opened the file or the region you have selected
with the Arrow Tool will be used instead.

Select a Page Size from the Page Size pop-up menu (Figure 19).  Popular page sizes are
available, but you can also enter a custom page size, or a page size not on  the menu, by
selecting Custom from the Page Size pop-up menu and entering the desired dimen-
sions in the text boxes.
Using Auto Transverter Pro Plus will calculate the smallest Page Size (Bounding Box)
that can surround all the objects within the input file.

Use EPS Bounds If Possible
If you are exporting a file you are viewing, this check box will not appear.  If this check
box is checked and the file is an EPS file, the page size will be drawn from Bounding
Box comment found in the input file.  In all other cases, the page size selected with the
Page Size pop-up menu will be used.

Text To Outlines
Transverter Pro Plus can also change the fonts contained in your image to text outlines.
If you would like this to always be done, select Always from the Text To Outlines pop-
up menu (Figure 28).  If you would like outline fonts to never be created, select Never.
Finally, if you would like Transverter Pro Plus to decide, choose When Appropriate.
For more information see the Text to Outlines section in the Reference Manual.

Figure 28 – Text To Outlines Options

Filters
You can select to filter objects from a PS or EPS file when transverting.  If you would
like to filter ALL bitmaps, paths, or text from your image, select the appropriate check
box or boxes from the three Filter Out check box options.  Refer to the Reference
Manual for more information.
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It is possible to create PostScript files for use with Transverter Pro Plus in almost any
application and on any platform.  There are two main ways to do this.  The first is use
your application to “Export” or “Save As” to PostScript or EPS.  The second is to “Print
to File” using a PostScript printer driver.

Export or Save As
In most popular applications, especially graphics applications, the option to Export or
Save As to a PostScript or EPS file is available.

If the Export option is available, select it.  After selecting it, you should be prompted for
the type of Export you would like.  Choose PostScript or EPS from these types if avail-
able.  If neither of these choices are available read the next section “Print to File.”  Once
you have chosen the file type, chose an appropriate name for the exported file and any
other options that are available.  After this step is finished, you should have a PostScript
or EPS file which can be copied to your Macintosh via a LAN, floppy disk, etc. and
used with Transverter Pro Plus.

Print to File
To Print to File, you are simply using a PostScript printer driver to send output to a file
instead of to a printer.  This output is exactly what the printer would receive and is what
you will see when you use it with Transverter Pro Plus.  Below is described how to do
this in the Macintosh and Microsoft Windows.  You may similarly create PostScript
files in any other operating sytstem such as Unix, NEXT, and OS/2.

Macintosh PostScript File Creation
1.  From the Apple menu, select the Chooser .
2.  In the Chooser, select a PostScript driver and printer.  Typically, the LaserWriter is
available.  The LaserWriter is also the preferred printer for use with Transverter Pro
Plus.  If the LaserWriter is not available in the Chooser, use your System install disks as
described in the Macintosh Users Manual to install the LaserWriter PostScript printer
driver then begin these instructions again.
3.  Close the Chooser window.
4.  Open the document you wish to print.
5.  Select Print  from the File menu.

Creating PostScript Files
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Creating PostScript Files

6.  When the Print window appears, check the radio button located beside PostScript
File if you are using System 7.x, or in the Destination box select File if you are using
System 7.5.
7.  Click on OK .
8.  When prompted, specify a filename and continue.  A PostScript file of your docu-
ment will be created using the filename you specified.

Microsoft Windows PostScript File Creation
Working in the Microsoft Windows environment you may need to create PostScript
files for Transverter Pro Plus to work with.  Making sure the proper fonts are available
to Transverter Pro Plus when a file is interpreted requires a small amount of special
planning, This is especially true if moving files from one machine to another where
installed fonts may be different.  All that is necessary is for you to install a printer that
we have tested extensively works with Transverter Pro Plus for easy cross-machine and
cross-platform font handling.  Please follow your specific platforms instructions for
installing a printer driver or making an EPS file.

An overview of creating PostScript files in a Microsoft Windows environment is to:
1.  Install a Transverter Pro Plus tested printer driver. Some tested drivers are available
in the Transverter Pro for Microsoft Windows manual at our web site.  A driver that
works well is the QMS ColorScript.

2.  In the application that you want to make a PostScript file from go to File : Print, then
select the printer listed above and print.  Your application will write out a PostScript file
to disk (.prn or .ps file).  Now use this file with Transverter Pro Plus.

Extensive instructions for doing this are found in the Transverter Pro 3.2 for Windows
Users Guide.  It is available, in Acrobat PDF format, at our website:
http://www.techpool.com.

Creating Encapsulated PostScript (EPS) Files
EPS files can be made directly in many applications.  For instance:

Quark - File : Save Page As EPS...
Illustrator - File : Save As... then save in EPS format
FreeHand - File : Export... make the format EPS
CorelDRAW - File : Export
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PostScript
PostScript (PS) is a sophisticated graphics programming language created by Adobe
Systems.  It provides a very flexible way for computer application programs to present
a page description to an output device.  For example, when a user prints to a PS laser
printer the computer sends PostScript code to the PS interpreter contained in the printer.
The PS interpreter does all of the work necessary to draw the described page.

To draw the page described in the PostScript description, the PS interpreter must trans-
late the PostScript into a collection of dots, much like a bitmap.  These dots will then be
used for printing the actual output.  This process of producing bitmap data from vector
and image data is called rasterizing.  Rasterizing can be performed by hardware, such
as a laser printer which contains a PS interpreter, or by software such as the Transverter
Level 2 PS interpreter.

Programs that are able to create PostScript for printing typically do not use PostScript
for editing and displaying.  They will use their own image format which is easier to
manipulate when editing then translate to PostScript when printing.  This translation is
most commonly done by a PostScript printer driver instead of the program itself.

EPS (Encapsulated PostScript)
Encapsulated PostScript (EPS) is an extension of PostScript that was created to allow
applications to "place" a PostScript image on a page.  Placing is used to incorporate a
smaller image into a document. EPS provides the information applications need to be
able to place and print an Encapsulated PS file.

Transverter supports EPS files, which are single page documents.  These files are typi-
cally created by designers, illustrators and ad agencies.

Adobe Acrobat (PDF) Files
The PDF (Portable Document Format) is becoming a universally accepted file format
for sharing documents on the Internet and on company Intranets.  It is a rich format
capable of containing text, fonts, images, and graphics that can easily be moved any-
where electronically.  Originally a superset of the Adobe Illustrator format it has grown
into a widely used file format.

PostScript Reference
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Transverter Pro Plus is designed to provide trouble free operation. However, should
you experience any difficulty in its operation, this section will assist you in determining
the problem source and give suggestions to fix it.

Not all applications produce clean print files.  If an application has made a PostScript
file improperly, Transverter Pro Plus may produce incorrect output or report an error in
the PostScript Messages window.

The diagnosis and correction of most PostScript errors goes beyond the scope of this
Users Guide.  However, there are a few common problems this chapter discusses to
remove a little of the PostScript mystique.

RAM Memory Issues
Transverter Pro Plus should be run on a machine with at least 16 megabytes of RAM,
although we strongly recommend at least 32 megabytes of RAM.

The interpreter engine will use as much RAM as you can provide and processing will
be faster with more RAM, within limits.

Machines that have small amounts of physical RAM and/or other applications running
while Transverter Pro Plus is printing may find that jobs progresses slowly.  You can try
three things, in the following order, to improve your print speed:

(1) Quit all non-essential applications
(2) increase the Systems Virtual Memory setting.
(3) increase the amount of physical RAM in your machine

Disk Space Issues
This is an issue when outputting high resolution raster files (TIFF, GIF, etc) and when
making PostScript files printed to disk.

When you are working from an application program, like PageMaker, and then want to
make a PostScript output file you select “Print PostScript to File” in the printer dialog
box options area.  This causes a print file to spool out to your hard drive.  In some cases
it can require more hard drive space then you have remaining. If you are working with
large complex documents these spooled files can grow to very large sizes when you
Print to File.

Troubleshooting
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Troubleshooting

For example, say you are working with a PageMaker document which has a single
placed photograph (300dpi RGB).  The photograph alone is 25 megabytes of data and
at least this much free disk space is required to print.  Now imagine that you have a
document with 5 placed RGB photographs.   The minimum total spooled file size will
be 125 megabytes requiring this much free disk space before you start the print job.

The bottom line here is to keep an eye on available hard drive space and not underesti-
mate how much you need.

Font Substitutions
When using Transverter Pro Plus, messages communicate to you in the PostScript Mes-
sages window about what fonts are being asked for by a file and, if the font is not
available, what font is substituted because of the font non-availability.

The example PostScript Message line below shows a file requesting the Helvetica font,
not finding it, and substituting ArialMT.
%%[ Finding Arial ]%%
%%[ Substituting Arial with Helvetica ]%%

Transverter Pro Plus uses Helvetica as its “Default Font.”  This is the font the inter-
preter will substitute when a specific font is not found.  You can change the Default
Font in the Font Options  dialog.

PostScript Errors
The Status Window will provide you with information about print processing.  From
time to time it may display an error message (in red) which stops print processing.  An
error message might look like this:
%%[ Error: interrupt; Offending Command: (- @interrupt -]%%
%%[Flushing:rest of job(to-end-of-file)will be ignored ]%%

There are two important pieces of information from Line 1 to write down here:
Line 1 the Error:  interrupt
Line 1 the Offending Command: @interrupt

At this point our Technical Support staff can be contacted for assistance.
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Troubleshooting

FAQ’s (Frequently Asked Questions)
Question
I receive an error message when trying to convert a larger or more complex file.
%%[Error: VMerror; OffendingCommand:--@image--]%%
%%[Flushing: rest of job (to end-of-file) will be ignored]%%

Answer:  Transverter Pro Plus may require more hard drive space to process your job,
see Disk Space Issues earlier in this chapter. It could also be that Transverter Pro Plus
requires more RAM to process the file.  Quit Transverter Pro Plus and do a Get Info to
increase the RAM.

Question
Transverter Pro Plus stops processing my file and produces many error messages in the
status window.

Answer: Be sure that the file you are processing is indeed a PS, EPS, or PDF file.
These files typically have a .ps, .eps, or .pdf at the end of the name.  You can also check
the content of the file by opening it in a text editor or word processor.  If the file is a PS
or EPS file, it should begin with “%!PS-Adobe” and be all text characters.  If the file is
a PDF file, it should begin with “%PDF” and be mixed text and binary data.  If your file
is not of one of these types, it is not supported by Transverter Pro Plus.

Question
When viewing my file with Transverter Pro Plus, my text does not look as it did when
I created the file and Transverter Pro Plus reports in the status window that a font sub-
stitution was needed.

Answer: When the file was created a font was used that was not embedded in the file.
Without this embedded font, Transverter Pro Plus must use the System installed fonts.
If the font can not be found on the System, a font substitution must be made.  Transverter
Pro Plus by default substitutes Helvetica, but you can customize font substitution in the
Font Options window.  Refer to the Font Options window section for details.
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Troubleshooting

Question
Transverter Pro Plus views the text in my EPS file fine, but when I transvert it to an AI
format and Open it, the text looks as if another font has been substituted.

Answer: EPS files can have embedded fonts which are used for displaying any text in
the file.  AI formats do not allow for embedded fonts, so when transverting from EPS to
AI, all embedded fonts are lost and replaced with references to the font.  If the font does
not exist on your System, your application can only substitute with another font.  The
solution is to either obtain and install the missing font or make the font into an outline
font with Transverter Pro Plus.  Please refer to the Outline Font section for details.

Question
How can I make my EPS files move cross-platform?

Answer: Use Transverter Pro Plus to make EPS files with a DOS TIFF Preview.  These
files are now supported by both Macintosh and Windows page layout programs so you
can share the files.

Question
I am trying to preview a PostScript file but I encounter an error?

Answer: Some PostScript files contain DSC Comments that cause problems with view-
ing and/or converting files.  After selecting File then Open check the Ignore DSC Com-
ments box then select your file to view.  This frequently solves the problem.
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Troubleshooting

Defective Disk Replacement
TechPool Software will replace defective or damaged disks free of charge during the
90-day limited warranty period.  After that period, damaged disks will be replaced for a
$15 charge per disk.  The defective disk must be returned to TechPool with a note
explaining the problem.

TechPool Software will not be responsible for disks lost or damaged in transit. If you
have not sent your registration card, you MUST send it with the defective disks.

Please send the defective or damaged disks with, if necessary, check, money order, or
credit card information.
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Troubleshooting

Contacting Technical Support
TechPool Software has a qualified Technical Support staff ready to help you with your
problems when using Transverter Pro Plus.  Please make sure the problem you are
having is with Transverter Pro Plus and not with your application software or System
fonts
.

Free Technical Support is provided
for 30 days from your first contact with Technical Support.

Thereafter Technical Support contracts may be purchased on an annual basis.
Contact our Customer Service to inquire about Support Contracts.

If you require technical support we can be reached via any of the following methods:
Mail .......................TechPool Software 1463 Warrensville Center Road

Cleveland, OH  44121-2676
Telephone.............. (216) 382-1787

9:00 am - 5:00 pm (U.S. Eastern Time)
Fax .........................(216) 382-4825
E-Mail ...................support@techpool.com
Web site: ................ www.techpool.com

When contacting us always provide the following information: Your name, company’s
name, address, daytime telephone number, fax number if available, e-mail address, the
type of system you are using, the application and version number, and a short but pre-
cise description of the problem including errors reported in the PostScript Messages.

Please call while sitting in front of your computer and be prepared to reproduce the
steps that caused the problem to occur.
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SOFTWARE LICENSE AGREEMENT FOR TECHPOOL CORPORATION
The computer program(s) ( SOFTWARE) that came with this Users Guide is licensed to you by
TechPool Corporation ( TechPool) for use only under the terms of this License, and TechPool re-
serves all rights not expressly granted to you.  The SOFTWARE is protected by copyright laws as
well as other intellectual property laws.
1.  GRANT OF LICENSE
This License allows you to:
(a)  Use one copy of the SOFTWARE on a single computer at a time.  To use the SOFTWARE means
that the SOFTWARE is either loaded in the temporary memory (i.e., RAM) of a computer or in-
stalled on the permanent memory of a computer (i.e., hard disk, etc.).  You may also store a copy of
the SOFTWARE on  a common storage device, such as a network server, for use only to install the
SOFTWARE on your other computers over an internal network; however, you must acquire and
dedicate a license for each separate computer on which the SOFTWARE is installed and run on.  A
license for the SOFTWARE may not be shared or used concurrently on different computers.
(b)  Make one copy of the SOFTWARE in machine readable form solely for backup purposes.  As an
express condition of this license, you must reproduce on each copy any copyright notice or  propri-
etary notice that is on the original supplied by TechPool.  No other copies are permitted.  You shall
agree not to copy the documentation that accompanied the SOFTWARE.
2.  RESTRICTIONS
 The SOFTWARE contains trade secrets and copyrighted materials.  You may not REVERSE ENGI-
NEER, DECOMPILE, DISASSEMBLE OR OTHERWISE REDUCE THE SOFTWARE TO ANY
HUMAN PERCEIVABLE FORM.  YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT,
LEASE, LOAN OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY
PART THEREOF.  Except as stated herein, this License does not grant you any rights to patents,
copyrights, trade marks, trade names, (whether registered or unregistered) or any other rights, or
licenses in respect to the SOFTWARE and its documentation.
3.  TERMINATION
This License is effective until terminated.  This License will be terminated immediately without
notice from TechPool or judicial resolution if you fail to comply with any provision of this License.
Upon such termination you must destroy the SOFTWARE, all accompanying written materials and
all copies thereof, and Sections 4, 5 and 6 will survive any termination.
4.  COPYRIGHT
All title and copyrights in and to the SOFTWARE (including but not limited to any images, photo-
graphs, animations, or text incorporated into the SOFTWARE) the accompanying printed materials
and any copies of the SOFTWARE product are owned by TechPool or its suppliers, with all rights
reserved.

Legaleze - software license
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Legaleze

5.  LIMITED WARRANTY
TechPool warrants for a period of ninety (90) days, from the original date of purchase, that (i) the
media (magnetic disk or CD) on which the SOFTWARE resides will be free from defects in materi-
als and workmanship under normal use, and (ii) the SOFTWARE as provided by TechPool will
substantially conform to TechPool’s published specification for the SOFTWARE.  TechPool's entire
liability and your exclusive remedy for any breach of the foregoing limited warranty will be, at
TechPool’s option, replacement of the media, refund of the purchase price or repair or replacement
of the SOFTWARE.

NO OTHER WARRANTIES.
THIS LIMITED WARRANTY IS THE ONLY WARRANTY PROVIDE BY TECHPOOL AND
TECHPOOL AND ITS LICENSORS EXPRESSLY DISCLAIM ALL OTHER WARRANTIES,
EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRAN-
TIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE WITH RE-
GARD TO THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS.  BECAUSE
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF IMPLIED
WARRANTIES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES.
IN NO EVENT WILL TECHPOOL, ITS PARENT OR SUBSIDIARIES OR ANY OF THE LICEN-
SORS, DIRECTORS, OFFICERS, EMPLOYEES OR AFFILIATES OF ANY OF THE FOREGO-
ING BE LIABLE TO YOU FOR ANY CONSEQUENTIAL DAMAGES, INCIDENTAL, INDI-
RECT OR SPECIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION,
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSI-
NESS INFORMATION AND THE LIKE), WHETHER FORESEEABLE OR UNFORESEEABLE,
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE OR ACCOMPANY-
ING WRITTEN MATERIALS, REGARDLESS OF THE BASIS OF THE CLAIM AND EVEN IF
TECHPOOL OR A TECHPOOL REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGE.

6.  GENERAL - This License is governed by the laws of the State of Ohio.  If any provision of this
License shall be held by a court of competent jurisdiction to be contrary to law, that provision will be
enforced to the maximum extent permissible, and the remaining provisions of this License will re-
main in full force and effect.  If you are a U.S. Government user than the SOFTWARE and documen-
tation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Govern-
ment is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data
and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Com-
mercial Computer Software-Restricted Rights clause at 48CFR 52.227-19, as applicable.
Manufacturer: TechPool Corporation 1463 Warrensville Center Road Cleveland OH 44121-2676.
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Bitmap Image
A bitmap image is stored as a collection of pixels.  A pixel represents one dot on your
screen or printer.  A simple way to think of a bitmap image is by putting a picture on a
fine grid.  Each square of the grid that is covered by the picture is one pixel and is
represented individually in the graphics file.  The pixel will be represented not only by
its location in the grid, but also by its color.

Embedded Font
An embedded font is a font that has been placed inside a document file.  Typically,
embedded fonts are added to files by the program that originally created the file to
ensure the output device will have the font available to recreate the text contained in the
file.  If the font was not available, another font would have to be used instead, yielding
text that is different than was originally intended.

Encapsulated PostScript (EPS)
EPS is a PostScript file that is limited to one page.  It is “encapsulated” so the file or
image can be placed into other documents.  It can also contain a PICT Preview in the
Resource Fork or a TIFF Preview in the Data Fork that will appear on-screen

Halftone
Halftone refers to how a computer image is printed by using a halftone cell.  Cell size is
related to the screen density (or lines per inch) and determines how dithering is done.

lpi (lines per inch)
lpi relates to halftoning and number of colors.   The more lpi the finer looking the dither
but the less colors.

PDF File Format (Adobe Portable Document Format)
PDF is an application independent file that contains all the elements created by the
original application. PDF files can be opened, moved and printed cross-platform
(Macintosh, Unix  & Windows).

Glossary
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PICT file format
A PICT file is the standard Macintosh graphics file format used in hundreds of applica-
tions. A PICT file can contain bit-mapped and vector graphics in one file.

PostScript (PS) file format
PostScript is a graphic programming language developed by Adobe Systems.  PostScript
contains text, graphics, and image data and is device independent.

PostScript (PS) Interpreter
A PostScript interpreter is any device or program that is able to understand and use the
PostScript language. Most PostScript interpreters are used to produce printed output.

Preflight
To interpret and preview a PostScript file before sending it to an output device to insure
its’ reliablity.

Preview
A preview is a special bitmap that is encapsulated, or contained, in an EPS file.  The
preview is meant to be a rough snapshot of what the entire image looks like.  It is
intended to provide applications with a means to display the contents of an EPS file
without actually interpreting it.

Printer Driver
A Printer Driver is a program that is used to convert application data to printer data that
the printer understands.

Softproof
Viewing a PostScript or PDF file after interpreting to insure it runs.

Spooling
A Printer Driver temporarily stores (spools) data onto a hard drive so that a printer or
application can then read it.

Glossary
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Chooser...37
CMYK...12, 29, 31
Color Image Operators...34
Color Space...12, 29, 31
Compression...30-32, 34
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